CHAPTER 2
Getting Started

In this chapter you will learn the basics of ZoomText,

including:

How to install and activate ZoomText.
How to start and exit ZoomText.
How to enable and disable ZoomText.

How to use the main ZoomText user interface
and tray icon.

How to get help on using ZoomText.

Although the information in this chapter should get you
up and running, please refer to the following chapters for
complete instructions.
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Installing ZoomText

ZoomText 9.0 is easy to install on your system. The
ZoomText CD includes a talking setup program with
large-print dialog boxes that guide you through the
installation. The setup program offers two methods of
installation: Automatic and Custom.

Automatic installation installs ZoomText using the
most common setup options (listed in the table
below). You are presented with fewer dialogs and the
installation is completed in less time.

Custom installation allows you to choose all of the
setup options.

The following table describes the setup options that are
applied during automatic installations.
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Automatic Installation

Setup Options Settings

Installation folder C:\Program Files\ ZoomText 9.0

Display a ZoomText Yes
icon on the Windows
desktop *

Start ZoomText No
automatically when
the system starts *

Speech synthesizers ** | ZoomText English-only version:
All English speech synthesizers
are installed.

ZoomText International versions:
TruVoice English and all
available synthesizers for the

selected language are installed.

This setting can be changed at any time after installing
ZoomText. This setting is located in ZoomText's
Program Preferences dialog. To open this dialog; in
the Settings menu, choose Program...

*5%

Speech synthesizer options only apply when installing
ZoomText Magnifier/Reader.
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» To install ZoomText

1. Disable virus-protection software and close all other
programes.

2. Insert the ZoomText 9.0 CD into the CD-ROM drive.
The ZoomText Setup program will start automatically.

3. Follow the on-screen instructions to complete the

installation.
» If Setup does not start automatically

1. Click on the Windows Start button and select Run...

2. Browse to your CD-ROM drive.

3. Select the Setup program and click Open.

4. Click OK in the Run dialog box.

Installing ZoomText in Windows XP, 2000 and NT 4.0

When you run ZoomText Setup in Windows XP, Windows
2000 or Windows NT 4.0, the setup program will install
system-level components. In order to install these
components you must have administrator privileges. If
you do not have these privileges, contact your network
administrator before proceeding with the installation.
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Downloading Program Components

>

If you obtained your ZoomText 9.0 software via
download from Ai Squared’s website, you may not have
received some of ZoomText’s optional program
components. These components include speech
synthesizers and product localizations (versions of
ZoomText in other languages). You can download these
components at any time.

Note: The selection of components that you can
download depends on the type of ZoomText
product installed on your system.

To download program components

In ZoomText's Help menu, select Download Program
Components...

Your web browser launches to the ZoomText program
components web page. A list of available components is
displayed along with instructions for downloading and
installing.
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Automatic Updating

ZoomText 9.0 includes automatic online version checking
and updating. This service keeps your installation of
ZoomText up-to-date with the latest fixes and
enhancements. Here's how it works...

Each time you start ZoomText, the Update Wizard checks
to see if you are online. If so, it quickly checks to see if
you are running the latest version. If an update is
available, the Update Wizard will ask if you want to
download it. By clicking on the 'Yes' button, the update
will download and install automatically.

Note: An Internet connection is required to use this

feature.
foomText Update Wizard g|
ZoomText Update is Available NS »

A ZoomText update is available For download, Updates
conkain important fixes and enhancements that will improve
the performance and compatibility of wour ZoomTexk
software,

Latest update version: | 9.01.0.76 More Information...

To proceed with the update, click the MNext butkon,

Check the box below and press the Close butkon to disable
automatic update checking.

[ IDisable automatic updates:

[ Hewst » l[ Cancel

ZoomText Update Wizard
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If you or your network administrator do not want to
check for updates each time you start ZoomText, you can
disable automatic updating as follows:

» To disable automatic updating

1. In the Settings menu, choose Program...

2. Uncheck Check for online updates each time
ZoomText is launched.

3. Click OK.

In addition to the automatic updating, you can manually
check for updates at any time.
» To manually check for updates

In the Windows Start menu, choose Programs »
ZoomText 9.0 » Check for Updates.

The Update Wizard appears and walks you through the
update procedure.
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Starting ZoomText 9.0

Once ZoomText is installed on your system, it can be
started using one of the following procedures.

e  On the Windows desktop, select the ZoomText 9.0
program icon.

e In the Windows Start menu, choose Programs »
ZoomText 9.0 » ZoomText 9.0.

Note: ZoomText can be configured to load automatically
when starting Windows. This option can be enabled
while installing ZoomText, or in the ZoomText
Preferences dialog box. For more information, see
"Program Preferences" in Chapter 5.

When ZoomText starts up, it changes your display to
show a magnified view of the normal screen. As you
move the mouse, type text and navigate within your
applications, the magnified view automatically scrolls,
keeping the area of activity in view.

If you have installed ZoomText Magnifier/Reader,
ZoomText will also speak aloud, narrating your actions as
you work with your documents and applications. All of
your Windows programs will operate normally while
ZoomText is running.
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Activating ZoomText 9.0

ZoomText 9.0 contains product activation technology
designed to eliminate unauthorized use of ZoomText,
without imposing a burden on legitimate users. Product
activation is a simple, straightforward and anonymous
process that takes just a few seconds to complete when
performed over the Internet.

After you install ZoomText you have up to 30 days to
activate the software. Until you do, ZoomText will run as
a trial. You can activate immediately or anytime during
the 30-day trial period. All features are available during
the trial period, so you have full use of the software.
When the trial period expires you must activate
ZoomText to continue using it.
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Preparing to Activate ZoomText

To activate ZoomText 9.0 you will need your ZoomText
9.0 serial number, provided with your purchased copy. If
you have purchased an upgrade version of ZoomText 9.0
you will also need the serial number from your previous
version of ZoomText (version 8.1 or earlier), unless your
previous version is already installed on your system.
These serial numbers can be found within your ZoomText
product packages, as described below.

» Where to find your ZoomText serial number
e On the ZoomText CD sleeve
e  On the product registration card
e  On the top of the ZoomText product box
¢  On the back of the ZoomText User's Guide

Note: If you purchased your ZoomText 9.0 product
from Ai Squared's online store, your product
serial number will be included in your
purchase confirmation email.
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The Activation Process

During the 30-day trial period, each time you start
ZoomText the Activation Wizard appears. The wizard
presents the following options for you to choose from:

Option 1: I have a serial number and want to
activate ZoomText

Choose this option if you have already purchased or
been provided with a ZoomText product and you're
ready to activate the software. The wizard will guide
you through the activation process.

Option 2: I want to purchase ZoomText

Choose this option if you are ready to purchase a
ZoomText product. The wizard will display
information on how to purchase ZoomText.

Option 3: I want to try ZoomText

Choose this option if you want to run ZoomText in
trial mode. Trial mode allows you to use ZoomText
for up to 30 days. When the 30-day trial period
expires, you must activate ZoomText to continue
using it.
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Foom Text Activation

Welcome to ZoomText 9.0

{* T have a serial number and want Lo activate ZoomText.

Enter wour serial number ta autamatically ackivate ZoomText - ik takes
only a few seconds,

" I want to purchase ZoomText.

‘fou can purchase ZoomText online or by phone. We will supply vou
with a setial number For activation,

" Iwant to try ZoomTexst. (30 days remaining)

There are 30 daws remaining in your trial period, When it ends, vou
musk activate ZoomTexk to conkinue using ik,

< Back | Hest » | LCancel | Help

The ZoomText Activation Wizard - Welcome dialog

When you choose to activate ZoomText you are prompted

to enter your product serial number. Once you have
entered your serial number, the manner in which

activation is completed depends on whether or not you

have an Internet connection.
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If you are connected to the Internet your serial
number and system code are automatically passed to
the Ai Squared activation server for validation. An
activation code is then passed back to your computer,
activating your ZoomText license. This process takes
just a few seconds to complete.

If you are not connected to the Internet the wizard
displays your serial number and system code, along
with instructions on how to manually obtain an
activation code. An activation code can be obtained
from Ai Squared's activation website (using another
computer that is connected to the Internet), or by
contacting Ai Squared's Product Support department.

Telephone activation support is available Monday
through Friday, 9am to 5pm Eastern Time.

In North America, call toll-free (866) 331-1233
Outside North America, call (802) 362-5393
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Activating a Magnifier/Reader installation with a
Magnifier serial number

If you have installed the ZoomText Magnifier/Reader
software and then activate ZoomText using a Magnifier
serial number, the software will convert to a ZoomText
Magnifier product - i.e. all screen reading features will be
disabled. To regain the use of the screen reading features,
you must purchase a Magnifier/Reader serial number and
reactivate ZoomText.

Activating ZoomText on more than one computer

With single-user versions of ZoomText, you can install
and activate ZoomText on up to three computers (in
accordance with the ZoomText Software License
Agreement). Multiple activations are provided to
accommodate individuals that use more than one
computer, such as a home computer, a work computer
and a laptop computer. While ZoomText may be installed
on up to three computers, use of the collective
installations is restricted to one user at any given time.

Note: Multi-user standalone versions of ZoomText
provide one activation per licensed user.
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Transferring Your ZoomText Software License

Should you want to move your ZoomText software to a
new computer, or need to reformat the hard drive on your
current computer, it is important that you first transfer
your software license back to the ZoomText activation
server. This preserves your license so that it may be used
to activate your new installation of ZoomText.

To transfer your ZoomText software license, from the
ZoomText menu bar, select Help » Transfer Software
License... This action will launch the ZoomText
Activation Wizard and guide you through the transfer
process. This process will deactivate ZoomText on your
current computer so that it can be reactivated on the new
computer.
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Frequently Asked Questions About Product Activation

What is product activation?

Product activation is an anti-piracy technology
designed to verify that ZoomText has been
legitimately licensed.

How does product activation work?

The activation process verifies that the serial number
is legitimate and has not been activated on more
computers than allowed by the ZoomText Software
License Agreement.

What happens if I don’t activate my product?

If you don’t activate your product by the 30th day
(after installation), ZoomText will stop working until
you activate it.

What if my product activation fails?

Product activation will only fail under exceptional
circumstances. In most cases, you can reactivate
ZoomText as quickly and easily as the original
activation. If your attempt to reactivate fails, contact
Ai Squared Product Support for help.

What if I need to reformat or upgrade my computer?
If you need to reformat your hard drive or upgrade
your Windows operating system, you should first
transfer your ZoomText software license back to the
ZoomText activation server. See "Transferring Your
ZoomText Software License" in the preceding section.

Note: You do not need to transfer your ZoomText
license when installing Windows service packs
and hot fixes.
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What if I want to move my ZoomText software to
another computer?

Should you want to move your ZoomText software to
a new computer, it is important that you first transfer
your software license back to the ZoomText activation
server. This preserves your software license so that it
may be used to activate your new installation of
ZoomText. See "Transferring Your ZoomText
Software License" in the preceding section.
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The ZoomText User Interface

When you start ZoomText its user interface appears on
the screen. This window contains all of the controls for
operating ZoomText. All of ZoomText's settings can be
accessed through standard menus or easy-to-use toolbars.
Each toolbar features a set of buttons that provide fast
access to the most important and frequently used settings.
Each button contains an intuitive icon and label for easy
identification. Buttons are grouped by function and each
group is labeled with a clickable link that opens the

group's associated dialog box (with the exception of the
Finders label).

Note: Features associated with magnification and screen
reading are grouped into separate toolbars and
dialogs. Features associated with screen reading
only appear in ZoomText Magnifier/Reader.
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Reader tab

Magnifier tab Minimize button

FA ZoomText 9.0 E| |E|E|

File Actions Magnifier Reader| 3Settings | Help
Q Magnifier @]} Reader _?J
oo Windows nhancements inders
Bl Z wind Enh k Find
7 =
- =
SN :PR@L I FEQR
FoomText Powet Twpe Color Poinker  Cursor Fonk | Deskkop  Web Text
Application: [[nkernet Explorer Readers
ZoomText butiton Help tool ’7
Status bar

ZoomText button Enables or disables ZoomText. When
disabled, all magnification and speech features are turned
off without exiting the program.

Magnifier tab Displays toolbar controls for ZoomText's
magnification features.

Reader tab Displays toolbar controls for ZoomText's
screen reading features. (ZoomText Magnifier/Reader only)

Help tool Displays help information about the clicked-
on item.

Status bar Displays the name of the active application
and informs you when AppReader and DocReader
("Readers"), reading zones ("Zones") and application
settings ("App Settings") are available for use.

Minimize button Hides the ZoomText user interface.
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Minimizing and Restoring the User Interface

The ZoomText user interface can be minimized (hidden)
and restored (made visible) without affecting the
operation of ZoomText.

» To minimize ZoomText

Do one of the following:

@ e On the ZoomText title bar, click on the minimize
button.

e  While the ZoomText user interface is active,
press ESC.

» To restore ZoomText

Do one of the following:
e (lick on the ZoomText 9.0 button in the task bar.

e DPress the Display User Interface hotkey:
CTRL + SHIFT + U.

Note: If the ZoomText user interface is already open but
covered by other applications, restoring it will
bring it into view.
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Enabling and Disabling ZoomText

You can enable and disable ZoomText at any time,
without exiting the program. When disabled, ZoomText
returns the screen to its normal (unmagnified) state and
all speech output is suspended.

» To enable ZoomText

S On the ZoomText user interface, select the ZoomText
& button.

zoomText ALT + INSERT

» To disable ZoomText

roomText Hotkey: ALT + DELETE

On the ZoomText user interface, select the ZoomText
button.
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Using the Tray Icon

When ZoomText is running, its program icon appears in
the system tray (next to the clock). Clicking on the tray
icon will pop up menus that contain important ZoomText
settings.

By left-clicking the tray icon, you can perform the
following:

e Enable and disable ZoomText
e Adjust the magnification level

e Start AppReader or DocReader
(ZoomText Magnifier/Reader only)

Erable ZoomTexk
Power

%, 2:57PM

Left-click menu

By right-clicking the tray icon, you can perform the
following;:

e Restore and minimize ZoomText

e Exit ZoomText

Restore ZoomTexk
Exit ZoomText

‘B %, 2i59Pm

Right-click menu
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Using Tools with the Keyboard

ZoomText's Adjust, Freeze and SpeaklIt tools allow you to
click and drag to select screen areas associated with their
respective features. Allow these tools were designed for
for easy use with a mouse, they can also be operated using
keyboard commands that simulate mouse actions. When
these tools are active, you can control them using the
keyboard commands from the following table.

Mouse Action Keyboard Command
Move the pointer UP, DOWN, LEFT, RIGHT
Left-click ENTER

Right-click ESC

Drag object right SHIFT + RIGHT

Drag object left SHIFT + LEFT

Drag object up SHIFT + UP

Drag object down SHIFT + DOWN
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Exiting ZoomText

You can exit the ZoomText program at any time. When
ZoomText is exited, the screen returns to its normal
(unmagnified) state and all speech output is terminated.

» To exit ZoomText
Do one of the following:

e In the File menu, choose Exit.

@ e In the ZoomText title bar, click the close box.



Chapter2 Getting Started ¢ 33

Uninstalling ZoomText

If you no longer need ZoomText on your system, you can
uninstall it at any time. Uninstalling ZoomText erases all

its program files and returns your system to the state it

was in before installing.

Before you uninstall ZoomText, you should be aware of

the following:

If you are running ZoomText in its 30-day trial period,
uninstalling the software will result in loss of all
remaining trial days. Reinstalling ZoomText will not
restore the trial days.

If your installation of ZoomText has been activated,
you should transfer your software license back to the
ZoomText activation server before uninstalling. This
will preserve your software license so that may be
used to activate ZoomText on another system. For
more information, see "Transferring Your ZoomText
Software License" in this chapter.

» To uninstall ZoomText

1.

In the Windows Start menu, choose Programs »
ZoomText 9.0 » Uninstall ZoomText 9.0.

2. Follow the on-screen instructions.

The ZoomText Uninstall program starts.



34

Getting Help

ZoomText provides the following documentation and
tools to help you learn and work with the program:

ZoomText 9.0 User's Guide Contains complete
information on using all ZoomText features and
commands.

ZoomText 9.0 Quick Reference Guide Provides
concise, user-friendly instructions for each of
ZoomText's essential features.

ZoomText 9.0 Online Help Contains all of the
information in the ZoomText 9.0 User's Guide,
optimized for use online. You can access complete
documentation directly from the user interface and
find topics using the Contents, Index, and Search
tabs.

ZoomText Help Tool Displays pop-up descriptions
for clicked-on items in the ZoomText toolbars.

What's This? Help Tool Displays pop-up
descriptions for clicked-on items in all ZoomText
dialog boxes.
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To use ZoomText Online Help
1. In the Help menu, choose ZoomText Help.
2. In the Help window, click one of the following tabs:

e Contents Lets you choose a topic from a
section of the online Help.

e Index Letsyou use the index to find a topic.

e Search Letsyou find a topic by searching for a
particular word or phrase in the online Help.

Note: Each ZoomText dialog box also contains a Help
button that, when selected, displays context-
sensitive Help for that dialog.

To use the ZoomText Help tool

1. On the ZoomText user interface, select the
ZoomText Help tool.

The Help Tool becomes active.
2. Move the pointer over a toolbar item.
3. Click to display a pop-up description for the item.
4. To exit the Help tool, right click or press ESC.

To use the What's This? Help tool

1. While in any ZoomText dialog, select the What's This?
Help tool (located in the title bar).

The What's This? tool becomes active.
2. Move the pointer over a dialog item.

3. Click to display a pop-up description of the item.
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